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LT0223A01 Copyright Baldor (c) 2007. All rights reserved.

This manual is copyrighted and all rights are reserved. This document or attached software may not,
in whole or in part, be copied or reproduced in any form without the prior written consent of Baldor.
Baldor makes no representations or warranties with respect to the contents hereof and specifically
disclaims any implied warranties of fitness for any particular purpose. The information in this
document is subject to change without notice. Baldor assumes no responsibility for any errors that
may appear in this document.

Mintt is a registered trademark of Baldor.
Windows 95, Windows 98, Windows ME, Windows NT, Windows 2000 and Windows XP are
registered trademarks of the Microsoft Corporation. UL and cUL are registered trademarks of
Underwriters Laboratories.

Limited Warranty
For a period of two (2) years from the date of original purchase, Baldor will repair or replace without
charge controls and accessories that our examination proves to be defective in material or
workmanship. This warranty is valid if the unit has not been tampered with by unauthorized persons,
misused, abused, or improperly installed and has been used in accordance with the instructions and/or
ratings supplied. This warranty is in lieu of any other warranty or guarantee expressed or implied.
Baldor shall not be held responsible for any expense (including installation and removal),
inconvenience, or consequential damage, including injury to any person or property caused by items of
our manufacture or sale. (Some countries and U.S. states do not allow exclusion or limitation of
incidental or consequential damages, so the above exclusion may not apply.) In any event, Baldor’s
total liability, under all circumstances, shall not exceed the full purchase price of the control. Claims for
purchase price refunds, repairs, or replacements must be referred to Baldor with all pertinent data as
to the defect, the date purchased, the task performed by the control, and the problem encountered. No
liability is assumed for expendable items such as fuses. Goods may be returned only with written
notification including a Baldor Return Authorization Number and any return shipments must be prepaid.

1 General Information 1
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Product notice
Only qualified personnel should attempt the start-up procedure or troubleshoot this equipment.

Precautions

WARNING: Danger of explosion if battery is incorrectly replaced. Replace only with the same
or equivalent type recommended by the manufacturer. Dispose of used batteries
according to the manufacturer’s instructions.

WARNING: Do not touch any circuit board, power device or electrical connection before you
first ensure that no high voltage is present at this equipment or other equipment to
which it is connected. Electrical shock can cause serious or fatal injury.

WARNING: Be sure that you are completely familiar with the safe operation and programming
of this equipment. This equipment may be connected to other machines that have
rotating parts or parts that are controlled by this equipment. Improper use can
cause serious or fatal injury.

WARNING: Do not use the HMI (Human Machine Interface) operator panel to directly control
motors or other actuators that are not equipped with additional safeguards, or
which could be potentially harmful in the event of a fault on the HMI operator
panel.

WARNING: Be sure all wiring complies with the National Electrical Code and all regional and
local codes. Improper wiring may result in unsafe conditions.

WARNING: Be sure the system is properly earthed/grounded before applying power. Do not
apply power before you ensure that earths/grounds are connected. Electrical
shock can cause serious or fatal injury.

CAUTION: The safe integration of the HMI operator panel into a machine system is the
responsibility of the machine designer. Be sure to comply with the local safety
requirements at the place where the machine is to be used. In Europe these are
the Machinery Directive, the ElectroMagnetic Compatibility Directive and the Low
Voltage Directive. In the United States this is the National Electrical code and local
codes.

CAUTION: Electrical components can be damaged by static electricity. Use ESD
(electrostatic discharge) procedures when handling this product.

CAUTION: Refer to EN60204-1 for guidelines on installing HMI operator panels.

CAUTION: To prevent equipment damage, be certain that input and output signals are
powered and referenced correctly.



www.baldormotion.com

General Information 1-3MN1932

CAUTION: To ensure reliable performance of this equipment be certain that all signals to/from
the HMI panel are shielded correctly.

CAUTION: Avoid locating the HMI panel in direct sunlight as this could cause premature
ageing of the front panel.

CAUTION: Avoid exposure of the HMI panel to corrosive substances or vapors, metal
particles and dust.

CAUTION: Do not use tools or sharp objects to operate the HMI operator panel buttons or
touchscreen.

CAUTION: Do not clean the HMI panel using solvents. Use only neutral soap based
solutions.
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2.1 HMI panel range
The Baldor HMI (HumanMachine Interface) panels provide an easy to use operator interface for
controlling machinery. They are designed to connect to a range of Baldor controllers and drives,
using either a serial connection or an optional CANopen interface.

A range of panels are available:

Keypads KPD-KG420-10 KPD-KG420-20 KPD-KG420-30 KPD-KG840-10

Screen Mono LCD Mono LCD Mono LCD Mono LCD

Pixels 120 x 32 120 x 32 120 x 32 240 x 64

Character display 4 x 20 4 x 20 4 x 20 8 x 40

Programmable
keys

4 9 12 23

Programmable
LEDs

5 9 12 24

Touchscreens KPD-
TS03M-10

KPD-
TS05M-10

KPD-
TS05C-10

KPD-
TS10C-20

KPD-
TS12C-20

Screen 3.8”
mono LCD

5.6”
mono LCD

5.6”
color STN

10.4”
color TFT

12.1”
color TFT

Pixels 320 x 240 320 x 240 320 x 240 640 x 480 800 x 600

Character display
(scalable)

16 x 40
max.

16 x 40
max.

16 x 40
max.

30 x 80
max.

40 x 100
max.

Available options include:
CBL034-501: PC to HMI panel RS232 serial cable (for programming).
CBL010MF-C: Controller to HMI panel CAN cable.
KPD-OPTC: CANopen interface card for HMI panel.
KPD-SW: Baldor HMI Designer programming software.
OPT033-501: Gender changer for CBL034-501 (KPD-KG420-10/20 / KPD-TS03M-10 only).

2 Introduction 2
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2.2 Receiving and inspection
When you receive your HMI panel, there are several things you should do immediately:

1. Check the condition of the shipping container and report any damage immediately to the
carrier that delivered your HMI panel.

2. Remove the HMI panel from the shipping container. The container and packing materials may
be retained for future shipment.

3. Verify that the catalog number of the HMI panel you received is the same as the catalog
number listed on your purchase order.

4. Inspect the HMI panel for external damage during shipment and report any damage to the
carrier that delivered your HMI panel.

5. If the HMI panel is to be stored for several weeks before use, be sure that it is stored in a
location that conforms to the storage humidity and temperature specifications shown in
section 8.1.5.

2.3 Units and abbreviations
The following units and abbreviations may appear in this manual:

A Ampere. . . . . . . . . . . . . . .
DC Direct current. . . . . . . . . . . . .
mA milliampere. . . . . . . . . . . . .
nF nanofarad. . . . . . . . . . . . . .
V Volt (also VAC and VDC). . . . . . . . . . . . . . .

in inch. . . . . . . . . . . . . . .
mm millimeter. . . . . . . . . . . . .
lb-in pound-inch (torque). . . . . . . . . . . . .
N·m Newton-meter (torque). . . . . . . . . . . . .

Kbaud kilobaud (the same as Kbit/s in most applications). . . . . . . . . . .
KB kilobytes. . . . . . . . . . . . . .
MB megabytes. . . . . . . . . . . . .

CCFL Cold Cathode Fluorescent Lamp. . . . . . . . . . .
LCD Liquid Crystal Display. . . . . . . . . . . .
LED Light Emitting Diode. . . . . . . . . . . .
STN Super Twisted Nematic. . . . . . . . . . . .
TFT Thin Film Transistor. . . . . . . . . . . . .

SSFDC Solid State Floppy Disk Card. . . . . . . . . .
RH Relative Humidity. . . . . . . . . . . . .

(NC) Not Connected. . . . . . . . . . . .
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3.1 Introduction
You should read all the sections in Basic Installation to ensure safe installation.
This section describes the mechanical and electrical installation of the HMI panel, including the
panel cutout, 24 V supply and optional CANopen module.

3.1.1 Hardware requirements
The components you will need to complete the basic installation are:

H An 18-30 VDC power supply for the HMI panel.
H An RS232 serial cable.
H A PC with the following specification:

Minimum specification Recommended specification

Processor Intel Pentium 133 MHz Intel Pentium 200 MHz or faster

RAM 32 MB 64 MB

Hard disk space 140 MB* 140 MB*

CD-ROM A CD-ROM drive

Serial port RS232 interface

Screen 800 x 600, 256 colors 1024 x 768, 256 colors

Mouse A mouse or similar pointing device

Operating system Windows 98, Windows ME,
Windows NT (3.51+), Windows 2000 or Windows XP

* The Baldor HMI Designer Studio software requires 140 MB disk for the installation
process, but once installed only uses 70 MB. Software installation will be described later, in
section 5.

H Your PC operating system user manual might be useful if you are not familiar with Windows.

3 Basic Installation 3
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3.2 Mechanical installation
The safe operation of this equipment depends upon its use in the appropriate environment; see
sections 1 and 8.1.5 for details. The HMI panels are designed to be panel mounted, as shown
in the following sections.

3.2.1 Faceplate and panel cutout dimensions
The following sections show the panel cutout and overall dimensions for each keypad.
Dimensions have a tolerance of approximately ±0.5 mm.

3.2.1.1 KPD-KG420-10

KPD-KG420-10 weighs approximately 1.0 kg (2.2 lb).

136
(5.35)

96
(3
.7
8)

53
(2.09)

149
(5.86)

10
9

(4
.2
9) Panel

Cutout

Maximum panel thickness:
5 mm (0.2 in)

Figure 1 - Panel cutout dimensions for KPD- KG420-10

3.2.1.2 KPD-KG420-20

KPD-KG420-20 weighs approximately 1.0 kg (2.2 lb).

136
(5.35)

96
(3
.7
8)

53
(2.09)

149
(5.86)

10
9

(4
.2
9) Panel

Cutout

Maximum panel thickness:
5 mm (0.2 in)

Figure 2 - Panel cutout dimensions for KPD- KG420-20
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3.2.1.3 KPD-KG420-30

KPD-KG420-30 weighs approximately 1.1 kg (2.4 lb).

128
(5.04)

16
3

(6
.4
2)

79
(3.11)

Maximum panel thickness:
5 mm (0.2 in)

141
(5.55)

17
6

(6
.9
3) Panel

Cutout

Figure 3 - Panel cutout dimensions for KPD-KG420-30

3.2.1.4 KPD-KG840-10

KPD-KG840-10 weighs approximately 2 kg (4.4 lb).

207
(8.15)

16
3

(6
.4
2)

80
(3.15)

Maximum panel thickness:
5 mm (0.2 in)

220
(8.66)

17
6

(6
.9
3) Panel

Cutout

Figure 4 - Panel cutout dimensions for KPD-KG840-10
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3.2.1.5 KPD-TS03M-10

KPD-TS03M-10 weighs approximately 1.0 kg (2.2 lb).

136
(5.35)

96
(3
.7
8)

61
(2.40)

149
(5.86)

10
9

(4
.2
9) Panel

Cutout

Maximum panel thickness:
5 mm (0.2 in)

Figure 5 - Panel cutout dimensions for KPD-TS03M-10

3.2.1.6 KPD-TS05M-10

KPD-TS05M-10 weighs approximately 1.4 kg (3.1 lb).

176
(6.93)

13
6

(5
.3
5)

79
(3.11)

Maximum panel thickness:
5 mm (0.2 in)

187
(7.36)

14
7

(5
.7
9) Panel

Cutout

Figure 6 - Panel cutout dimensions for KPD-TS05M-10



www.baldormotion.com

Basic Installation 3-5MN1932

3.2.1.7 KPD-TS05C-10

KPD-TS05C-10 weighs approximately 1.4 kg (3.1 lb).

176
(6.93)

13
6

(5
.3
5)

91
(3.58)

Maximum panel thickness:
5 mm (0.2 in)

187
(7.36)

14
7

(5
.7
9) Panel

Cutout

Figure 7 - Panel cutout dimensions for KPD-TS05C-10

3.2.1.8 KPD-TS10C-20

KPD-TS10C-20 weighs approximately 2.25 kg (5 lb).

276
(10.87)

22
1

(8
.7
0)

91
(3.58)

Maximum panel thickness:
5 mm (0.2 in)

287
(11.99)

23
2

(9
.1
3) Panel

Cutout

Figure 8 - Panel cutout dimensions for KPD-TS10C-20

3.2.1.9 KPD-TS12C-20

KPD-TS12C-20 weighs approximately 2.85 kg (6.3 lb).

326
(12.83)

25
6

(1
0.
1)

91
(3.58)

Maximum panel thickness:
5 mm (0.2 in)

337
(13.28)

26
7

(1
0.
51
)

Panel
Cutout

Figure 9 - Panel cutout dimensions for KPD-TS12C-20
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3.2.2 Mounting
Ensure that the perimeter of the cutout aperture is flat and there are no burrs. The supplied
self-adhesive gasket must be fitted around the cutout aperture to provide sufficient ingress
protection. The gasket will either be a rectangular gasket of the correct size, or straight strips of
gasket material.

Attach the single
gasket to the
border of the
panel cutout. Do
not stretch the
gasket.

Mount the HMI
panel.

Insert the fixing brackets in the slots around the
edge of the HMI panel and tighten the screws.
Most panels have four slots, but larger panels
may have as many as ten.

Attach the thin
gasket to the
border of the panel
cutout. Start from
half way along the
bottom. Do not
stretch the gasket
material. The two
ends should meet
with no overlap.

Attach the thick gasket around the
rear edge of the bezel. Start from one third
along the bottom. Do not stretch the gasket.
The two ends should meet with no overlap.

Rectangular gasket Straight gaskets

1/3 2/3

1/2

1/2

Figure 10 - Panel mounting
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3.2.3 Installing the optional CANopen module (KPD-OPTC)
If the optional CANopen module has been ordered then it must be fitted inside the HMI panel
back cover. Remove power from the HMI panel before installing the CANopen module.

1. If present, remove the two screws (A) at
the sides of the rear cover and lift off the
cover. On some HMI panels it may be
necessary to remove the cover by
inserting a screwdriver at the sides of the
cover (B) and then gently levering it off.

2. Plug the CANopen module into the two
red connectors on the HMI panel’s
circuit board. Push down firmly until the
connectors are fully mated, and the two
supporting pillars are engaged in the
holes on the CANopen module.

CAUTION! Electrical components can be damaged by static electricity. Use ESD (electrostatic
discharge) procedures when handling the HMI panel and CANopen module.

A

A
B

3. To replace the cover, first insert the tabs on
the cover into the slots on the HMI panel.

For lever-off covers, simply push down on
the cover until it snaps into place. On
screw down covers, a small amount of
pressure might be required to hold down
the cover while the screws are tightened.

After replacing the cover, attach the
supplied label to the rear panel, somewhere
near the AUX PORT label. This will indicate
that the CANopen module has been fitted.

Figure 11 - CANopen module installation
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3.2.4 Power connections
A 24 VDC supply must be provided to power the HMI panel.

Location Orange 3-pin connector (Weidmüller BLZ 5.00/3)

Nominal input
voltage

24 VDC

Range 18-30 VDC

Input current
(maximum@ 24V)

KPD-KG420-10: 250 mA
KPD-KG420-20: 250 mA
KPD-KG420-30: 300 mA
KPD-KG840-10: 400 mA
KPD-TS03M-10: 400 mA
KPD-TS05M-10: 600 mA
KPD-TS05C-10: 600 mA
KPD-TS10C-20: 700 mA
KPD-TS12C-20: 800 mA

Tightening torque for terminal block connections is 0.4-0.5 N·m (3.5-4.4 lb-in).

Connect +24 V to the terminal labeled 24 V. Connect 0 V to the terminal labeled 0 V. Connect the
(protective earth) terminal to the large screw/faston terminal marked with the same

symbol. The power supply to the HMI panel may be either grounded or ‘floating’. For a grounded
power supply, connect 0 V to the terminal, as shown by the dashed line in Figure 12. For a
floating power supply, do not connect 0 V to the terminal. Note that the internal HMI panel
circuitry connects 0 V to via a 1 MΩ resistor in parallel with a 10 nF capacitor. See also
section 4.1.2.1 for details about powering the CAN bus.

STAR
POINT

Incoming safety
earth/ground (PE)

+24 VDC
0 V

Customer supplied
24 VDC (fused)

24V
0V

Figure 12 - 24 VDC power supply connections

3.2.5 Battery protector
SomeHMI panels contain a backup battery to retain the date and time, event list and recipe data.
To prevent the battery becoming discharged during shipping and storage, a plastic battery
protector film marked “Remove, Battery Protection” insulates the battery contacts. Pull firmly to
remove this film before attempting to use the HMI panel.
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3.2.6 Battery replacement
The HMI panel’s backup battery is a CR2430, 3 V 270 mA button cell. To replace it, the
secondary rear cover must be removed. For models fitted with the CANopen module, it may be
necessary to remove the top cover first (see section 3.2.3).

1. Remove the four screws
securing the secondary cover.

3. Replace the 3 V cell
mounted on the
underside of the
circuit board,
observing the
correct polarity.

4. Replace the cover, ensuring that the
circuit board connectors mate with
those on the rear of the HMI panel;
this might require a small amount of
pressure.

2. Gently pull upwards on the secondary
cover. This will unplug the enclosed
circuit board from the HMI panel.

CAUTION! Electrical components can be damaged by static electricity. Use ESD (electrostatic
discharge) procedures when handling the HMI panel.
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3.2.7 Memory card

Thememory on some HMI panels is provided by a SmartMedia card (also known
as SSFDC memory). This is supplied already inserted in the HMI panel, and
should only be removed from its slot if necessary. Note that the supplied card
has a tape attached to its outer edge to allow easy removal; other memory cards
should also have similar tape attached.

Contamination of the card’s gold contacts can generate an insulating layer that
may result in electrical contact problems with the socket. Before inserting a new

memory card, the contact area should be carefully cleaned to remove contaminants such as oil,
grease of fingerprint residue. Acidic chemicals may permanently damage the contacts.

Do not use a synthetic material to clean the card as this could cause electrostatic discharge
which could permanently damage the internal flash memory. When transporting SmartMedia
cards, always use an antistatic protective case.
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3.2.8 Connection summary - controller without USB port
Figure 13 shows the typical connection between the HMI panel, PC and a controller without a
USB port, for example MintDriveII. The 24 VDC power supply connection is not shown.

II

COM1

Cable 1 is the only cable required during normal operation.
Cable 2 is required when using Designer to program the HMI panel.
Cable 3 is required when using Mint WorkBench to program the controller.
Cables 1 and 3 both use the controller’s serial port, so must be swapped when necessary.
On KPD-KG420-10 / 20 and KPD-TS03M-10, cables 1 and 2 share the PLC port, so must be swapped when necessary.
If the PC has only one COM port, cables 2 and 3 must be swapped when necessary.

AUX PORT PLC PORT PC/PRINTER

COM2

Designer to HMI panel

Mint WorkBench to Controller

HMI panel to Controller1 2

3

II

COM1

AUX PORT PLC PORT PC/PRINTER

COM2

Designer to HMI panel

Mint WorkBench to Controller

HMI panel to Controller1 2

3

Cable 1 is the only cable required during normal operation.
Cable 2 is required when using Designer to program the HMI panel.
Cable 3 is required when using Mint WorkBench to program the controller.
On KPD-KG420-10 / 20 and KPD-TS03M-10, cable 2 is connected to the PLC port.
If the PC has only one COM port, cables 2 and 3 must be swapped when necessary.

Serial HMI panel

CANopen HMI panel

Controller

Controller

Figure 13 - Connecting the HMI panel, PC and controller (without USB port)
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3.2.9 Connection summary - controller with USB port
Figure 14 shows the typical connection between the HMI panel, PC and a controller with a USB
port, for example NextMove ESB. The 24 VDC power supply connection is not shown.

COM1

Cable 1 is the only cable required during normal operation.
Cable 2 is required when using Designer to program the HMI panel.
Cable 3 is required when using Mint WorkBench to program the controller.
On KPD-KG420-10 / 20 and KPD-TS03M-10, cables 1 and 2 share the PLC port, so must be swapped when necessary.

AUX PORT PLC PORT PC/PRINTER

USB

Designer to HMI panel

Mint WorkBench to Controller USB

HMI panel to Controller1

2

3

COM1

AUX PORT PLC PORT PC/PRINTER

USB

Designer to HMI panel

Mint WorkBench to Controller USB

HMI panel
to Controller

1

2

3

Cable 1 is the only cable required during normal operation.
Cable 2 is required when using Designer to program the HMI panel.
Cable 3 is required when using Mint WorkBench to program the controller.
On KPD-KG420-10 / 20 and KPD-TS03M-10, cable 2 is connected to the PLC port.

Serial HMI panel

CANopen HMI panel

CAN

USB

USB

Se
ria
l

Se
ria
l

Controller with
USB port

Controller with
USB port

Figure 14 - Connecting the HMI panel, PC and controller (with USB port)
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4.1 Introduction
This section describes the communication ports on the HMI panels.

4.1.1 PLC port (RS232 / RS422/485)

Location PLC PORT or PC/PLC PORT
15-pin D-type male connector (not high density)

Pin Name Description
1 Shield Shield connection

2 RXD RS232 receive

3 TXD RS232 transmit

4 +5 V +5 V output (100 mA max)

5 0 V GND Ground

6 TX- RS422/RS485 transmit

7 RX- RS422/RS485 receive

8 (NC) Not connected

9 (NC) Not connected

10 RTS RS232 Request To Send

11 CTS RS232 Clear To Send

12 (NC) Not connected

13 (NC) Not connected

14 TX+ RS422/RS485 transmit

15 RX+ RS422/RS485 receive

The PLC PORT provides signals for RS232 or RS422/RS485 communication with the controller.
The method of communication that is used is determined by the cable.

7 RTS

8 CTS

3 TXD

2 RXD

5 GND

1

RXD 2

TXD 3

GND 5

HMI panel
PLC PORT

Baldor controller
RS232 serial port

Twisted pair

Figure 15 - RS232 cable wiring

4 Input / Output 4
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8 RX+

2 RX-

7 TX+

3 TX-

5 GND

1

RX+ 15

RX- 7

GND 5

Baldor HMI
PLC PORT

TX+ 14

TX- 6

Twisted pair

Baldor controller
(except NextMove BXII)

RS422/485 port

Figure 16 - RS422/485 cable wiring (except NextMove BXII)

8 RX-

2 RX+

7 TX-

3 TX+

5 GND

1

RX+ 15

RX- 7

GND 5

Baldor HMI
PLC PORT

TX+ 14

TX- 6

Twisted pair
Baldor NextMove BXII

RS422/485 port

Figure 17 - RS422/485 cable wiring - NextMove BXII

4.1.1.1 Programming using the PLC port (KPD-KG420-10 / 20 and KPD-TS03M-10 only)

Models KPD-KG420-10, KPD-KG420-20 and KPD-TS03M-10 do not have a PC/PRINTER port
(section 4.1.3), so the PLC port is also used for programming the HMI panel when it is in
configuration mode. Baldor cable CBL034-501 (not supplied) must be used in conjunction with
gender changer OPT033-501 (not supplied) to connect the PLC port to a standard 9-pin serial
(COM) port on the PC.
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4.1.2 AUX port (CANopen)

Location AUX PORT
9-pin D-type female connector

Pin Name Description
1 (NC) Not connected

2 CAN- CAN signal

3 CAN GND Ground

4 (NC) Not connected

5 Shield Shield connection

6 CAN GND Ground

7 CAN V+ CAN signal

8 (NC) Not connected

9 (NC) Not connected

When the optional CANopen module KPD-OPTC is fitted (see section 3.2.3), the CANopen
signals become available on the AUX port. Baldor cable CBL010MF-C (not supplied) connects
the 9-pin D-type AUX port to the RJ45 CANopen connector on the controller.

If the CANopen module is not fitted, the AUX port is not used.

4.1.2.1 Powering the CAN bus

On many Baldor controllers, a power supply is required to drive the opto-isolated CAN port. To
do this, cable CBL010MF-C can bemodified to route the HMI panel’s 24 V supply along the CAN
cable to the controller. See the instruction manual supplied with the controller for details.

Alternatively, CAN D-type to RJ45 adaptors OPT-CNV001 (for the HMI panel) and
OPT-CNV002 (for the controller) can be used, as shown in Figure 18. These adaptors convert
the D-type connections to RJ45 sockets, and also allow power to be applied to the CAN bus.

Cat 5e
cable

OPT-CNV001

HMI panel

OPT-CNV002

Controller

24 V input possible
at either end

RJ45 RJ45

Figure 18 - CAN D-type to RJ45 adaptors
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4.1.3 PC / PRINTER port

Location PC / PRINTER PORT
15-pin D-type female connector (not high density)

Pin Name Description
1 Shield Shield connection

2 RXD RS232 receive

3 TXD RS232 transmit

4 +5 V +5 V output (100 mA max)

5 0 V GND Ground

6 (NC) Not connected

7 (NC) Not connected

8 (NC) Not connected

9 (NC) Not connected

10 RTS RS232 Request To Send

11 CTS RS232 Clear To Send

12 (NC) Not connected

13 (NC) Not connected

14 (NC) Not connected

15 (NC) Not connected

The PC / PRINTER port provides RS232 signals for communication with the PC that will be used
for programming the HMI panel. The HMI panel is programmed using the Baldor HMI Designer
Studio software KPD-SW, which can be ordered separately. Baldor cable CBL034-501 (not
supplied) connects the PC / PRINTER port to a standard 9-pin serial (COM) port on the PC.

4.1.3.1 Models without a PC/PRINTER port

Models KPD-KG420-10, KPD-KG420-20 and KPD-TS03M-10 do not have a PC / PRINTER
port, so the PLC port is used for programming the HMI panel. See section 4.1.1.1.
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5.1 Introduction
Before connecting the HMI panel you will need to install the PC software Baldor HMI Designer
Studio, part KPD-SW. This software includes all the required tools to configure and program the
HMI panel. If you do not have experience of software installation or Windows applications you
may need further assistance for this stage of the installation.

5.1.1 Installing the software
Run the setup.exe program and follow the on-screen instructions. The setup wizard will copy the
files to appropriate folders on the hard disk. The default folder is C:\Program Files\Baldor HMI
Software, although this can be changed during setup.

Baldor HMI Designer Studio (referred to simply as Designer) is a fully featured application for
programming the HMI panels. The main Designer window contains a menu system, the Toolbox
and other toolbars. Many functions can be accessed from the menu or by clicking a button - use
whichever you prefer. Most buttons include a ‘tool-tip’; hold the mouse pointer over the button
(don’t click) and its description will appear.

Toolbox

Menu system Toolbars

Project screen

Workspace

Figure 19 - The Baldor HMI Designer Studio software

5 Configuration 5
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5.1.2 Help file
Designer includes a comprehensive help file that contains information about every control and
menu. On the left of the help window, the Contents tab shows the tree structure of the help file.
Each book contains a number of topics (double click a topic name to display it). The Index
tab provides an alphabetic list of all topics in the file, and allows you to search for them by name.
The Search tab allows you to search for words or phrases appearing anywhere in the help file.
Many words and phrases are underlined and highlighted with a color (normally blue) to show that
they are links. Just click on the link to go to an associated keyword.

Figure 20 - The Baldor HMI Designer Studio help file
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5.2 Main HMI panel controls
Many of the HMI panels have a similar range of control keys. Since touchscreenmodels have no
physical keys, they provide equivalent on-screen graphical keys when needed.

Cursor keys. Scroll up / down, previous / next page.

Enter / accept.
Press for three seconds to enter configuration mode.
In configuration mode: Single press displays the type and version of
communication driver installed (if any). Pressing for two seconds
returns the panel to normal operation mode (if a valid
communication driver and and project are in the unit).
In normal operation mode: Pressing for two seconds displays the
command menu.
In command menu: accepts the menu selection.

Enter data entry mode. Used to activate numeric fields to accept
data entry. When in data entry mode, use the cursor keys to move
to other numeric fields.

Print page / cancel printing.
See the Designer help file for more information.

Enter password insert mode.
See the Designer help file for more information.

Enter clock setting mode (if available).
Use the cursor keys and return key to set and move between fields.
When complete, press the exit key.

Exit. Exits clock setting mode. Also exits an active data entry field,
replacing or leaving the original value.

Most other keys can be programmed to perform a large number of functions using Designer’s
Keyboard Macro Editor tool, available on the Project menu. The key graphics shown in this tool’s
dialog may not exactly match the keys on your particular panel, and not all available keys may
have a physical equivalent on your HMI panel. See the Designer help file for more information
about the Keyboard Macro Editor tool.

Note: The KPD-KG840-10 has a large number of programmable keys with alphabetic
characters on them. These correspond to the keys F1 to F23 shown in the
Keyboard Macro Editor tool.
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5.2.1 Forced configuration mode
An HMI panel must be in configuration mode to allow Designer to transfer data. If an HMI panel
will not enter configuration mode by pressing the enter key (or bottom right hand corner of the
touchscreen) for three seconds, an alternative method is available to force configuration mode.

H On models with a physical keypad, remove power from the HMI panel. Press and hold
down any three keys and then re-apply power. Wait until the HMI panel enters
configuration mode, then release the three keys.

H On touchscreen models, remove power from the HMI panel. Touch and hold the middle of
the left side of the display, re-apply power and immediately start tapping the center of the
screen about once per second until the HMI panel enters configuration mode.

5.2.2 Touchscreen calibration
It may be necessary to calibrate the touchscreen to ensure that on-screen controls are
accurately triggered by the correct areas of the touchscreen surface.

H Press and hold the bottom right hand corner of the touchscreen to enter Configuration
mode.

H Touch and hold the clear key until a symbol appears at the top right of the screen.

H Touch and hold the symbol until it moves to the bottom left of the screen.

H Touch and hold the new symbol until a symbol appears. Repeat this process for each
symbol until the enter key is displayed. Press and hold the enter key to complete the
calibration and return to normal operation mode.

5.2.2.1 Forced calibration mode

If a touchscreen HMI panel will not enter calibration mode, use the following procedure. Remove
power from the HMI panel. Re-apply power and immediately start tapping the center of the
screen about once per second until the HMI panel enters calibration mode.
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5.3 Configuring Designer for a serial HMI panel
The following section describes how to configure Designer for communication with a serial HMI
panel. To start Designer, go to the Windows Start menu and select Programs, Baldor HMI
Software, Baldor HMI Software.

5.3.1 Selecting the serial driver
To simplify the driver selection process, the HMI panel should be disconnected from the PC.

1. On the File menu, choose New to start a new project.

2. In theNewProject window, type a name
for the project and click OK.

3. On the Project menu, select Configure
Controller... .

Click Select protocol.

4. In theSelect Controller window, choose
the Baldor driver. This must be version
4.04 (or later), and DLL version 5.05 (or
later).

Note: If the highlighted serial driver is an
earlier version then it will need to be
updated. To do this, close Designer and
then download the latest serial driver
from www.baldormotion.com. Copy the
downloaded file (D32Uplcxxx.dll) to the
Baldor HMI installation directory (typically C:\Program Files\Baldor HMI Software),
overwriting the existing file of the same name. Restart Designer, and in the Select Controller
dialog, click Refresh. The new version will now be listed.
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5.3.2 Configuring the node ID
A Baldor serial HMI panel operates as a master device, so the node ID of the connected
controller must be specified. If the panel is being connected to a RS422/485 network of
controllers, then the node ID of each controller must be specified.

1. In the Select Controller window, click
Controller Setup to display the Setup
dialog.

2. If there is only one controller connected to the HMI
panel, click in the Slave ID box and enter the node
number of the controller.

If there are many networked controllers, check the
Access Multiple Ctrl option to display an extended
setup dialog. Click Add to select a controller,
choose the controller type and its node ID, then
click OK. Repeat as necessary for each controller
to be addressed by the HMI panel.

The Use HCP2 check box is available only for
controllers that support Host Comms Protocol 2.
HCP2 allows access to the controller’s extended
comms array; see theMint WorkBench help file for
details.

The Ctrl Comm... button displays a dialog where
the serial connection’s parameters can be
configured. All Baldor controllers use no parity, 8
data bits and 1stop bit, so thesesettings shouldnot
be altered. The baud rate must be set to match the
baud rate being used by the connected
controller(s). The maximum practical value that
should be used is 19200 baud.

3. Click each dialog’s OK button to return to the
project screen.
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5.3.3 Connecting the HMI panel to the PC
Designer can use any COM port on the PC, provided other software is not trying to access the
same port.

1. Turn on the 24 VDC supply to the HMI
panel.

2. On the Transfers menu, select
Options... .

3. On thePorts tab, select theCOMport to
which the HMI panel is connected.
Parity should be set to None, and Stop
Bits set to 1. The HMI panel will
automatically recognize the selected
baud rate.

4. Click OK to close the Properties dialog.
5. Now connect the serial cable between

the chosen PC serial port and the HMI
panel’s PC/PRINTER port.

Note: Models KPD-KG420-10, KPD-KG420-20 and KPD-TS03M-10 do not have a
PC/PRINTER port, so the PLC port is used for programming the HMI panel. Baldor
cable CBL034-501 (not supplied) must be used in conjunction with gender changer
OPT033-501 (not supplied) to connect the PLC port to a standard 9-pin serial
(COM) port on the PC.
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5.3.4 Selecting the HMI panel model
Designer needs to determine which HMI panel has been connected so that the correct
programming environment can be created. The simplest method is to upload the necessary
information from the HMI panel.

1. To program the HMI panel, it must be in
configuration mode. For keypad
models, press and hold the enter key

for three seconds. For touchscreen
models, press and hold the bottom right
corner of the touchscreen for three
seconds. The display will show a
number of options.

2. Use the arrow keys to highlight the
CONFIG (or CFG) option, then press
the enter key. The HMI panel will
indicate that it is in configuration mode.

3. To upload information about the HMI
panel, go to the Transfers menu and
choose Get Panel Resources. The
Panel Resources dialog will be shown.

4. Click Yes to copy the information to the
Designer project.
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5.3.5 Downloading data to the HMI panel
The communication protocol and the project (which contains the node ID and baud rate settings)
should now be downloaded to the HMI panel. Any protocol already on the HMI panel should be
deleted first.

1. Ensure that the HMI panel is in configuration mode
(described in section 5.3.4).

On the Tools menu, choose Advanced, Erase
Protocols in Panel. Confirm the deletion.

2. On the Transfers menu, choose Options... to
display the transfer Properties dialog. On the
Transfer advanced tab, confirm that theBothoption
and the ‘Do not download protocol if exists in the
target’ option are both selected. Click OK to exit.

3. On the Transfers menu, choose Download. The
downloadwill begin immediately.When the transfer
is complete, click OK to close the dialog.

4. On the Filemenu, chooseSave to save the project.
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5.4 Configuring Designer for a CANopen HMI panel
The following section describes how to configure Designer for communication with a CANopen
HMI panel. To start Designer, go to the Windows Start menu and select Programs, Baldor HMI
Software, Baldor HMI Software.

5.4.1 Selecting the CANopen driver
To simplify the driver selection process, the HMI panel should be disconnected from the PC.

1. On the File menu, choose New to start a new project.

2. In theNewProject window, type a name
for the project and click OK.

3. On the Project menu, select Configure
Controller... .

Click the ... button.

4. In theSelect Controller window, choose
the CANopen driver. This must be
version 4.06 (or later), and DLL version
5.04 (or later).

Note: If the highlighted CANopen driver
is anearlier version then itwill need tobe
updated. To do this, close Designer and
then download the latest CANopen
driver from www.baldormotion.com.
Copy the downloaded file
(D32Uplcxxx.dll) to the Baldor HMI installation directory (typically C:\Program Files\Baldor
HMI Software), overwriting the existing file of the same name. Restart Designer, and in the
Select Controller dialog, click Refresh. The new version will now be listed.
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5.4.2 Configuring the node ID and baud rate
A Baldor CANopen HMI panel operates as a slave device, so it is necessary to assign its node
ID and CAN baud rate.

1. In the Select Controller window, click
Controller Setup to display the Setup
dialog.

2. Click in the Panel NodeID box and enter a node ID
for theHMI panel. This must be between2 and127,
since node 1 is always used by the controller (the
manager node). Node 3 has been selected in this
example.

Click in the Baud Rate box and select the CAN
baud rate (500 Kbit/s in this example). This must be
the same baud rate used by all other CAN nodes in
the network.

3. Click each dialog’s OK button to return to the
project screen.

5.4.3 Connecting the HMI panel to the PC
Designer can use any COM port on the PC, provided other software is not trying to access the
same port.
1. Turn on the 24 VDC supply to the HMI

panel.
2. On the Transfers menu, select

Options... .
3. On thePorts tab, select theCOMport to

which the HMI panel is connected.
Parity should be set to None, and Stop
Bits set to 1. The HMI panel will
automatically recognize the selected
serial baud rate.

4. Click OK to close the Properties dialog.
5. Now connect the serial cable between

the chosen PC serial port and the HMI
panel’s PC/PRINTER port.

Note: Models KPD-KG420-10, KPD-KG420-20 and KPD-TS03M-10 do not have a
PC/PRINTER port, so the PLC port is used for programming the HMI panel. Baldor
cable CBL034-501 (not supplied) must be used in conjunction with gender changer
OPT033-501 (not supplied) to connect the PLC port to a standard 9-pin serial
(COM) port on the PC.
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5.4.4 Selecting the HMI panel model
Designer needs to determine which HMI panel has been connected so that the correct
programming environment can be created. The simplest method is to upload the necessary
information from the HMI panel.

1. To program the HMI panel, it must be in
configuration mode. For keypad models,
press and hold the enter key for three
seconds. For touchscreen models, press
and hold the bottom right corner of the
touchscreen for three seconds. The
display will show a number of options.

2. Use the arrow keys to highlight the
CONFIG (or CFG) option, then press the
enter key. TheHMI panel will indicate that
it is in configuration mode.

3. To upload information about the HMI
panel, go to the Transfers menu and
choose Get Panel Resources. The Panel
Resources dialog will be shown.

4. Click Yes to upload the information to
Designer.
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5.4.5 Downloading data to the HMI panel
The communication protocol and the project (which contains the node ID and baud rate settings)
should now be downloaded to the HMI panel. Any protocol already on the HMI panel should be
deleted first.

1. Ensure that the HMI panel is in configuration mode
(described in section 5.3.4).

On the Tools menu, choose Advanced, Erase
Protocols in Panel. Confirm the deletion.

2. On the Transfers menu, choose Options... to
display the transfer Properties dialog. On the
Transfer advanced tab, confirm that theBothoption
and the ‘Do not download protocol if exists in the
target’ option are both selected. Click OK to exit.

3. On the Transfers menu, choose Download. The
downloadwill begin immediately.When the transfer
is complete, click OK to close the dialog.

4. On the Filemenu, chooseSave to save the project.
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5.4.6 Controller to HMI panel CANopen connection
This subsection only applies to HMI panels with the optional CANopen module KPD-OPTC. If
you have a serial HMI panel, go straight to section 6.

If all the previous steps have been followed, the HMI panel should now be in normal operation
mode. Ensure that a CAN cable is connected between the controller and the HMI panel’s AUX
port, and that termination resistors are fitted or switched in where necessary. A serial connection
between the PC and the controller will also be required.

To enable CANopen communication between the controller and the HMI panel, the controller
must set up a connection to the HMI panel. The Mint WorkBench software (supplied with the
controller) is used to issue the required Mint commands from the controller.

1. If your PC has only one COM port, it may be
necessary to close Designer before usingMint
WorkBench.

Start the Mint WorkBench software and
connect to the controller.

2. To allow the controller to configure the CAN
connection it must have node ID 1, which
makes it the CANopen manager node. By
default, Baldor controllers areset tonode 2.On
the Mint WorkBench Tools menu, choose
Options... . On the Communication tab, select
node ID 1 and click OK.

The controller must now issue a number of commands to connect to the HMI panel. These can
either be entered individually in the Command Window, or written as a program which can be
compiled and downloaded to the controller (select the Edit & Debug tool and then press Ctrl+N
to open a program editing window).
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3. Enter the commands:

BUSBAUD(1) = 500
BUSRESET(1)
NODETYPE(1, 3) = 0
NODESCAN(1, 3)

BUSBAUD(1) = 500 sets the controller’s CANopen interface to operate at 500 Kbit/s, the
same rate as chosen for the HMI panel in section 5.4.2, step 2.
BUSRESET(1) resets the controller’s CANopen interface.
NODETYPE(1, 3) = 0 disconnects any existing node with node ID 3.
NODESCAN(1, 3) scans for node ID 3 (as chosen for the HMI panel in section 5.3.2, step 2.),
and causes it to become ‘live’.

4. After the program has been downloaded and
run, check that the panel is ‘live’, by clicking in
the command window and typing the
command:

Print NODELIVE(1, 3)

The controller should return the value 1,
indicating that the HMI panel is ‘live’.

5. Finally, the connection to the HMI panel is
made using the command:

CONNECT(1, 1, 3) = 1

The HMI panel is now ready for programming.
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6.1 Introduction
The following examples demonstrate how to read, write and display information on the HMI
panel. Separate descriptions are provided for programming serial and CANopen HMI panels,
due to the different way in which the controller / HMI panel connection operates. To avoid
confusion, only read the sections that are relevant to your HMI panel.

After the serial / CANopen programming examples, section 6.4 explains the Mint code that can
be used on the controller to respond to the actions of the HMI panel.

The examples do not form a comprehensive guide to the features of each HMI panel. For this
information refer to Designer’s help file, accessible from the Help menu.

6.1.1 Cable connections during programming
During the programming stage, it may be necessary to swap certain cables depending on the
ports available on the PC, controller and HMI panel. If at any stage communication between any
two devices appears to have failed, check that the correct connections have been made.

Connections are summarized in sections 3.2.8 and 3.2.9.

6 Programming 6
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6.2 Programming a serial HMI panel
A serial HMI panel acts as a master device, reading and writing data held in the controller’s
‘comms array’ memory. This array has 99 read/write elements (memory locations) that can hold
integer or float data. The HMI panel uses the Baldor ‘host comms protocol’ (HCP1) to access the
controller’s comms array. Some Baldor controllers also support an enhanced version of the host
comms protocol known as HCP2. In addition to elements 1 to 99, HCP2allows access to a range
of read only elements known as the extended comms array (elements 100 to 255). These
elements contain important information such as the axis position, axis demand and error status.
To allow the HMI panel to access extended comms array elements, the ‘Use HCP2’ box on the
controller setup dialog must be checked - see section 5.3.2, step 2.

The controller can access its comms array by using the Mint COMMS keyword, specifying the
element number. Section 6.2.1.1 will demonstrate the use of the COMMS keyword.

6.2.1 Displaying data (read only)
This example demonstrates how to make the HMI panel read data from the controller. This stage
of this example uses Designer, so the PC’s COM port must be connected to the HMI panel’s
programming port.

1. First, a label needs to be placed on the
screen to describe the value to be shown.

Click on the yellow programming area and
type something descriptive, for example
Count:

2. Click the Numeric Field button, then drag
a rectangle on the yellow screen area next
to the label.

The field will be used to display the value
read from the controller.
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3. The Numeric Field Properties dialog
appears immediately.

In the Style box, confirm that Numeric is
selected.

TheWidth specifies the number of digits in
the field. This example will require 5 digits,
so enter 5 in the Width box.

Confirm that Reference is set to PLC (the
controller).

Click the ... button.

4. The Data Field Properties dialog defines
the comms element (Address Reference)
from which the HMI panel will derive its
data, and the data type.

Set the Data Type to Comms Raw.

The controller’s comms element (Address
Reference) will change to COMMS RAW
1. TheAddressOffset andData Formatdo
not need to be altered.

ClickOK to close theData FieldProperties
dialog.

5. Click the Range tab, and confirm that the
Read Only option is set.

Click OK to close the dialog.

The yellow programming area will now
show the field as 99999.

6. On theFilemenu, chooseSave to save the
project.

Set the HMI panel into configuration mode
(see section 5.3.4 if you cannot remember
how to do this).

On the Transfers menu, choose
Download. The download will begin
immediately. When the transfer is
complete, click OK to close the dialog.

The HMI panel will exit configurationmode
and the program will start.

Note: If the program does not start automatically, go to the Transfers, Options menu. On
the Transfers tab, check that the Start program after download option is checked.
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6.2.1.1 Testing the connection

To test the connection, a program that continuously increments comms element 1 will be
downloaded to the controller and started. The HMI panel will then monitor the changing value in
the controller’s comms element 1.

Note: For non-USB controllers, the single RS232/RS485 serial port will be used by both
the PC and the HMI panel during testing. It will therefore be necessary to download
the program to the controller, run the program, disconnect the PC from the
controller, then connect the HMI panel to the controller.

1. Start Mint WorkBench and connect to the
controller. Select the Edit & Debug tool,
press Ctrl+N to open a program editing
window, and enter the following
statements:

Dim Count As Integer = 0
Loop

Comms(1) = Count
Count = Count + 1
If Count>99999 Then Count=0
Wait(1000)

End Loop

Download and run the program.

2. (If necessary, disconnect the PC serial
cable from the controller and connect the
HMI panel serial cable.)

The HMI panel should now display the
incrementing value in the numeric field.
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6.2.2 Displaying and changing data (read / write)
This example demonstrates how to make the HMI panel read data from the controller, and allow
the user to change the data using the HMI panel. For example, the user might wish to enter a
length for a cutting machine application. This stage of this example uses Designer, so the PC’s
COM port must be connected to the HMI panel’s programming port.

1. First, a label needs to be placed on the
screen to describe the value to be edited.

Click on the yellow programming area and
type something descriptive, for example
Length:

2. Click the Numeric Field button, then drag
a rectangle on the yellow screen area next
to the label.

3. The Numeric Field Properties dialog
appears immediately.

In the Style box, confirm that Numeric is
selected. Confirm that the Format is set to
Decimal and Unsigned.

Click the Fixed Point option and enter a
Placement value of 1. This causes the field
to display one decimal place.

TheWidth specifies the number of digits in
the field. This example will require 6 digits
(including the decimal point), so enter 6 in
the Width box.

Confirm that Reference is set to PLC (the
controller).

Click the ... button.
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4. The Data Field Properties dialog defines
the comms element (Address Reference)
from which the HMI panel will derive its
data, and the data type.

Set the Data Type to Comms.

Set the controller’s comms element
(Address Offset) to 2.

Set the Data Format to DBLE WORD.

ClickOK to close theData FieldProperties
dialog.

5. Click the Range tab, and confirm that the
Read/Write option is set.

Set theminimum range to a constant value
of 1.

Set the maximum range to a constant
value of 1200.0

6. Click OK to close the dialog.

The yellow programming area will now
show the field as 9999.9.

7. On theFilemenu, chooseSave to save the
project.

Set the HMI panel into configuration mode
(see section 5.3.4 if you cannot remember how to do this).

On the Transfers menu, choose Download. The download will begin immediately. When the
transfer is complete, click OK to close the dialog.

The HMI panel will exit configuration mode and the program will start.

Note: If the program does not start automatically, go to the Transfers, Options menu. On
the Transfers tab, check that the Start program after download option is checked.
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8. Set the HMI panel into data entry mode.
For most HMI panels, this is the key
marked 0 or INS, as shown opposite.

For touchscreens, press the numeric field.

Enter a value for the length, for example
23.4, then press the enter key. For
touchscreens, use the on-screen up/down
arrow keys to enter the value.

6.2.2.1 Testing the connection

If necessary, reconnect the PC serial cable to the controller.

1. Start Mint WorkBench and connect to the
controller. In the Command window, type:

Print Comms(2)

The value just entered using theHMIpanel
should be displayed in the command
window. This confirms that the HMI panel
succeeded in writing a value to the
controller’s comms array.

0 or

or
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6.2.3 Triggering actions
It is often necessary for controls on an HMI panel to directly control the physical actions of the
controller, such as making a motor turn or activating a digital output. This is very similar to the
read/write example in section 6.2.2, except that a single command key on the HMI panel will
directly control an action by writing predefined values into the specified comms element. A key
control can perform different actions when it is pressed down, released, or held down. In the
following example, the F2 key will be programmed to write 1 when it is pressed down, and write
0 when it is released. For HMI panels that do not have a key marked F2, an alternative key can
be chosen. This stage of this example uses Designer, so the PC’s COM port must be connected
to the HMI panel’s programming port.

1. Open the All Pages entry in the menu
tree. Double-click theAll Pages folder.
The Configure Macro Keys dialog
appears immediately.

2. Double-click the F2 key to add it to the
Configured Keys column.

Click OK.

Note: A key can also be added or
deleted by right-clicking on it.

3. Expand the F2 entry. This provides
three options for defining what will
happen when the F2 key is pressed,
released, or held down.

Double-click Key Pressed to define
what will happen when the key is
pressed down.
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4. In the Edit Macro List dialog, click the
Write to Controller... button. The Data
Field Properties dialog appears
immediately.

5. Select the data type Comms Raw,
data format DBLE WORD, and
Address Offset 3 (i.e. controller
comms element 3).

Click OK to close the Data Field
Properties dialog.

The Macro Parameter Value dialog
appears immediately. This setting
defines the value that will be sent to
comms element 3 when the key is
pressed down. Enter a value of 1 and
click OK.

Click OK to close the Edit Macro List
dialog.

6. Double-click Key Released to define
what will happen when the key is
released.

Repeat step 5. above, except enter
the value 0 in the Macro Parameter
Value dialog.

Click OK to close the Macro Editor
dialog.

Click OK to close the Edit Macro List
dialog.
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7. On the File menu, choose Save to save the project.

Set the HMI panel into configuration mode (see section 5.3.4 if you cannot remember how to
do this).

On the Transfers menu, choose Download. The download will begin immediately. When the
transfer is complete, click OK to close the dialog.

The HMI panel will exit configuration mode and the program will start. In section 6.4, an example
Mint program shows how the controller can be made to react when the F2 (or alternative) key is
pressed.

Note: If the program does not start automatically, go to the Transfers, Options menu. On
the Transfers tab, check that the Start program after download option is checked.
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6.3 Programming a CANopen HMI panel
An HMI panel fitted with the optional KPD-OPTC CANopen module acts as a slave device, with
the controller (the manager node) reading and writing data held in the HMI panel’s memory. The
HMI panel has two memory arrays that can be accessed by the controller. One array holds
integer data and the other holds float data. To access the integer array, the controller uses the
COMMS keyword, specifying the node number of the HMI panel and an array element (memory
location) in the range 1 to 254. To access the float array, element numbers in the range 255 to
508 are used, where 255 corresponds to memory location 1 (FLOAT-1) in the HMI panel’s float
array. Section 6.3.1.1 will demonstrate the use of the COMMS keyword.

6.3.1 Displaying data (read only)
This example demonstrates how to make the HMI panel read data that has been sent from the
controller. This stage of this example uses Designer, so the PC’s COM port must be connected
to the HMI panel’s programming port.

1. First, a label needs to be placed on the
screen to describe the value to be shown.

Click on the yellow programming area and
type something descriptive, for example
Count:

2. Click the Numeric Field button, then drag
a rectangle on the yellow screen area next
to the label.

The field will be used to display the value
read from the controller.
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3. The Numeric Field Properties dialog
appears immediately.

In the Style box, confirm that Numeric is
selected.

In the Format area, select Decimal and
Unsigned.

TheWidth specifies the number of digits in
the field. This example will require 5 digits,
so enter 5 in the Width box.

Confirm that Reference is set to PLC (the
controller).

Click the ... button.

4. The Data Field Properties dialog defines
thememory location (Address Reference)
where the HMI panel will store the data,
and the data type.

Since the count value will always be an
integer, set the Data Type to INT32_DB.
The HMI panel’s memory location
(Address Reference) will change to
INT32-1.
Confirm that the Data Format is set to
DBLE WORD(Bin).

ClickOK to close theData FieldProperties
dialog.

5. Click the Range tab, and confirm that the
Read Only option is set.

Click OK to close the dialog.

The yellow programming area will now
show the field as 99999.

6. On theFilemenu, chooseSave to save the
project.

Set the HMI panel into configuration mode
(see section 5.3.4 if you cannot remember
how to do this).

On the Transfers menu, choose
Download. The download will begin
immediately. When the transfer is
complete, click OK to close the dialog.
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The HMI panel will exit configuration mode and the program will start.

Note: If the program does not start automatically, go to the Transfers, Options menu. On
the Transfers tab, check that the Start program after download option is checked.

6.3.1.1 Testing the connection

Ensure that the controller’s serial port (or USB port) is connected to the PC. If your PC only has
one COM port, you can disconnect the HMI panel’s programming cable. To perform testing, a
program that continuously increments the value in memory location INT32-1 will be downloaded
to the controller. The HMI panel can then display the changing value in its memory location.

1. Start Mint WorkBench and connect to the
controller. Select the Edit & Debug tool, press
Ctrl+N to open a program editing window, and
enter the following statements. These are the
same statements that were used in section
5.4.6, but because the HMI panel has been
interrupted by downloading the project, they
must be re-issued:

BUSBAUD(1) = 500
BUSRESET(1)
NODETYPE(1, 3) = 0
NODESCAN(1, 3)
Pause NODELIVE(1, 3)
CONNECT(1, 1, 3) = 1

Download and run the program.

TheadditionalPause statement causes theprogramtowaitmomentarily until theHMIpanel’s
CANopen module reports that it has become ‘live’; only then is the CONNECT statement
issued.

2. To send a value to theHMI panel, click in the
command window and type the command:

Comms(3, 1) = 25467

However, newer controllers such as
NextMove e100 require the command:

REMOTECOMMSINTEGER(1, 3, 1) = 25467

TheHMI panel should now display the value
25467 in the numeric field.

See the Mint help file for details of the
COMMS, REMOTECOMMS and
REMOTECOMMSINTEGER keywords.
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6.3.2 Displaying and changing data (read / write)
This example demonstrates how to allow the user to change data using the HMI panel. For
example, the user might wish to enter a length for a cutting machine application. This stage of
this example uses Designer, so the PC’s COM port must be connected to the HMI panel’s
programming port.

1. First, a label needs to be placed on the
screen to describe the value to be edited.

Click on the yellow programming area and
type something descriptive, for example
Length:

2. Click the Numeric Field button, then drag
a rectangle on the yellow screen area next
to the label.

3. The Numeric Field Properties dialog
appears immediately.

In the Style box, confirm that Numeric is
selected. Confirm that the Format is set to
Decimal and Unsigned.

Click the Fixed Point option and enter a
Placement value of 1. This causes the field
to display one decimal place.

TheWidth specifies the number of digits in
the field. This example will require 6 digits,
so enter 6 in the Width box.

Confirm that Reference is set to PLC (the
controller).

Click the ... button.
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4. The Data Field Properties dialog defines
thememory location (Address Reference)
where the HMI panel will store the data,
and the data type.

Since fractional values may be entered,
set the Data Type to FLOAT_DB.

Set the HMI panel’s memory location
(Address Offset) to be 1.

Set the Data Format to be FLOAT.

ClickOK to close theData FieldProperties
dialog.

5. Click the Range tab, and confirm that the
Read/Write option is set.

Set theminimum range to a constant value
of 1.0 .

Set the maximum range to a constant
value of 1200.0 .

6. Click the Scaling tab and set A2 to 1. A1
should be set to 1 and B should be set to
0.

Click OK to close the dialog.

The yellow programming area will now
show the field as 9999.9.

7. On theFilemenu, chooseSave to save the
project.

Set the HMI panel into configuration mode
(see section 5.3.4 if you cannot remember
how to do this).

On the Transfers menu, choose
Download. The download will begin
immediately. When the transfer is
complete, click OK to close the dialog.
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The HMI panel will exit configuration mode and the program will start.

Note: If the program does not start automatically, go to the Transfers, Options menu. On
the Transfers tab, check that the Start program after download option is checked.

8. Set the HMI panel into data entry mode. Formost
HMI panels, this is the key marked 0 or INS, as
shown opposite.

For touchscreens, press the numeric field.

Enter a value for the length, for example 23.4,
then press the enter key. For touchscreens, use
the on-screen keypad or up/down arrow keys to
enter the value.

6.3.2.1 Testing the connection

Ensure that the controller’s serial port is connected to a COMport on the PC. If your PC only has
one COM port, you can disconnect the HMI panel’s programming cable.

1. Start Mint WorkBench and connect to the
controller. In the Command window, type:

Print Comms(3, 255)

or, for newer controllers such as
NextMove e100:

Print REMOTECOMMS(1, 3, 255)

where 3 is the node number that was assigned to the HMI panel in section 5.4.2, and 255
is the HMI panel’s FLOAT-1memory location (see the introduction to section 6.3). The value
just entered using theHMI panel should be displayed in the commandwindow. This confirms
that the HMI panel succeeded in writing a value to its own memory location.

See the Mint help file for details of the COMMS and REMOTECOMMS keywords.

0 or

or
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6.3.3 Triggering actions
It is often necessary for controls on an HMI panel to directly control the physical actions of the
controller, such as making a motor turn or activating a digital output. This is very similar to the
read/write example in section 6.3.2, except that a single command key on the HMI panel will
directly control an action by writing predefined values into the specified comms element. A key
control can perform different actions when it is pressed down, released, or held down. In the
following example, the F2 key will be programmed to write 1 when it is pressed down, and write
0 when it is released. For HMI panels that do not have a key marked F2, an alternative key can
be chosen. This stage of this example uses Designer, so the PC’s COM port must be connected
to the HMI panel’s programming port.

1. Open the All Pages entry in the menu
tree. Double-click theAll Pages folder.
The Configure Macro Keys dialog
appears immediately.

2. Double-click the F2 key to add it to the
Configured Keys column.

Click OK.

Note: A key can also be added or
deleted by right-clicking on it.

3. Expand the F2 entry. This provides
three options for defining what will
happen when the F2 key is pressed,
released, or held down.

Double-click Key Pressed to define
what will happen when the key is
pressed down.
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4. In the Edit Macro List dialog, click the
Write to Controller... button. The Data
Field Properties dialog appears
immediately.

5. Click the Write to Controller... button.
The Data Field Properties dialog
appears immediately.

Select the data type INT32_DB, data
format DBLE WORD, and Address
Offset 3 (i.e. integer memory location
3). Click OK to close the Data Field
Properties dialog.

The Macro Parameter Value dialog
appears immediately. This setting
defines the value that will be written to
integer memory location 3 when the
key is pressed down. Enter a value of
1 and click OK.

Click OK to close the Edit Macro List
dialog.

6. Double-click Key Released to define
what will happen when the key is
released.

Repeat step 5. above, except enter
the value 0 in the Macro Parameter
Value dialog.

Click OK to close the Macro Editor
dialog.

Click OK to close the Edit Macro List
dialog.
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7. On the File menu, choose Save to save the project.

Set the HMI panel into configuration mode (see section 5.3.4 if you cannot remember how to
do this).

On the Transfers menu, choose Download. The download will begin immediately. When the
transfer is complete, click OK to close the dialog.

The HMI panel will exit configuration mode and the program will start. In section 6.4, an example
Mint program shows how the controller can be made to react when the F2 (or alternative) key is
pressed.

Note: If the program does not start automatically, go to the Transfers, Options menu. On
the Transfers tab, check that the Start program after download option is checked.
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6.4 Monitoring HMI panel actions using Mint
The methods used to detect user input on the HMI panel are slightly different for serial and
CANopen HMI panels. To avoid confusion, only read the section that is relevant to your HMI
panel.

6.4.1 Using a serial HMI panel
A Mint program on the controller can be used to monitor changes to the controller’s comms
elements. In section 6.2.2, a value entered in the HMI panel’s numeric field was written into
comms element 2 on the controller. The following Mint program continuously polls comms
element 2 to check for changes made by the HMI panel:

Dim fOldLength As Float
Loop

’Has the user changed product length?
If Comms(2) <> fOldLength Then

subNewLengthEntered
fOldLength = Comms(2)

End If
End Loop

This program calls a subroutine called subNewLengthEntered whenever the contents of
comms element 2 changes.

However, a much more efficient method is available using the Mint comms events. Mint
automatically generates a comms event whenever data is written to any of the first five comms
elements (from a source other than the Mint program itself). This event can be detected by
adding a corresponding COMMSx event construct to the Mint program (where x is in the range 1
to 5). This is muchmore efficient than the polling method shown above, as theMint program only
executes the event code when necessary. The comms event can be used to start a task (on
multi-tasking controllers) or a subroutine that handles the new HMI data.

The following example defines an event called COMMS2 that will only be executed when there is
a change to comms element 2. The event definition begins with the statement Event COMMS2
and ends with the line End Event. The event code calls a task called NewLength to perform an
action; for controllers without multi-tasking capability such as Flex+DriveII, the task could be
replaced by a subroutine.

Event COMMS2
’User changed Product Length
Run NewLength

End Event

Task NewLength
fProductLength = Comms(2)

End Task

In section 6.2.3, when the F2 key was pressed down, the value 1 was written into comms
element 3 on the controller. When the key was released, the value 0 was written into comms
element 0 on the controller. The followingMint program includes an event to react to the changes
in comms element 3:
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RESET
Loop

End Loop

Event COMMS3
If Comms(3) = 1 Then

Jog(0) = 1000
Else

Stop
End If
End Event

For testing purposes, the Loop..End Loop construct is a simple way to prevent the program
ending; the program will remain in this loop until interrupted by the comms events. When the
event is triggered, the If Comms(3) = 1 statement tests if the key has been pressed (i.e. has
written the value 1). If it has, the Jog(0) = 1000 statement is executed, causing the motor to
jog. If the value is not 1 it must be 0, indicating that the key must have been released. The
program therefore jumps to the Else statement, allowing the following Stop statement to be
executed, stopping the motor.

6.4.2 Using a CANopen HMI panel
A Mint program on the controller can be used to monitor changes in the memory locations on the
CANopen HMI panel. In section 6.3.2, a value entered in the HMI panel’s numeric field was
written into float memory location 1. The following Mint program continuously polls float memory
location 1 (i.e. comms element 255) to check for changes made by the HMI panel:

Dim fOldLength As Float
Loop

’Has the user changed product length?
If Comms(3, 255) <> fOldLength Then

subNewLengthEntered
fOldLength = Comms(3, 255)

End If
End Loop

This program calls a subroutine called subNewLengthEntered whenever the contents of the
HMI panel’s float memory location 1 changes.

However, a muchmore efficient method is available using CANopen ‘bus events’. Whenever the
HMI panel writes data to one of its memory locations, it generates a CANopen bus event. This is
recognized by the controller as a Mint type 12 bus event, which has the predefined constant
_betHMI_COMMS_UPDATE. This can be read in Mint using the BUSEVENT keyword. The bus
event also includes information about which memory location changed, which can be read in
Mint using the BUSEVENTINFO keyword.

The bus event can be detected by adding a BUS1 event construct to the Mint program. This is
much more efficient than the polling method shown above, as the Mint program only executes
the event code when necessary. The BUS1 event can be used to start a task (on multi-tasking
controllers) or a subroutine that handles the new HMI data. The following example defines the
BUS1 event code that will only be executed when the HMI panel issues a bus event. The event
definition begins with the statement Event BUS1 and ends with the line End Event.
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RESET
BUSBAUD(1) = 500
BUSRESET(1)
NODETYPE(1, 3) = 0
NODESCAN(1, 3)
Pause NODELIVE(1, 3)
CONNECT(1, 1, 3) = 1

Loop

End Loop

Event BUS1
Dim nEvent As Integer
Dim nInfo As Integer
nEvent = BUSEVENT(1) ’Read event type into a variable
nInfo = BUSEVENTINFO(1) ’Read event info into a variable

Select Case nEvent
Case _betHMI_COMMS_UPDATE ’User changed data on HMI

Select Case nInfo ’Test which memory location changed
Case 255 ’User changed Product Length

Run NewLength ’Run a task
Case 3 ’User pressed F2

Print “User pressed F2”
If Comms(3, 3) = 1 Then

Jog(0) = 1000
Else

Stop
End If

’Add cases for other adjustable values here
End Select

Case Else
’Add cases for other bus events such as node live

End Select
End Event

Task NewLength
fProductLength = Comms(3, 255)
’As an example, code in the rest of task may calculate new move
’parameters based on new value of Product Length entered by user

End Task

For testing purposes, the Loop..End Loop construct is a simple way to prevent the program
ending; the program will remain in this loop until interrupted by the bus events. When the event
is triggered, the first Select Case construct tests if the event type is an HMI comms update. If
it is, the inner Select Case construct tests the BUSEVENTINFO to determine which memory
location has changed. If it is location 255 (the HMI panel’s float memory location 1) the
NewLength task is called, which reads the product length from the HMI panel. If it is location 3
(the HMI panel’s integer memory location 3), the value is tested; if 1 the motor is jogged, if 0 the
motor is stopped.
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On more recent controllers such as NextMove e100, any Comms statement will need to be
replaced with either REMOTECOMMS or REMOTECOMMSINTEGER. For example:

If Comms(3, 3) = 1 Then

will need to be replaced with:

If REMOTECOMMSINTEGER(1, 3, 3) = 1 Then

For testing, the Print statement shows when the action has occurred - click the Terminal tab
below Mint WorkBench’s Output window to see the result. Other Print statements can be
added where necessary to confirm the operation of the code.

By using this style of program, any type of bus event can be detected. Similarly, using the
example of the HMI comms update bus event shown above, changes in any of the HMI panel’s
memory locations could be tested by simply adding further Case xxx statements inside the
inner Select Case construct.

See the Mint WorkBench help file for details of each keyword.
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6.5 Additional information
For clarity, the examples in sections 6.2 and 6.3 specified only the options required to complete
the example. In many case, other options were available; these are outlined below.

6.5.1 Numeric field properties dialog
The ASCII option allows alphanumeric data to be exchanged between the HMI panel and a
controller. However, a Baldor controller’s comms array can only handle numeric data, so the
ASCII option cannot be used.

The Format option provides a hexadecimal option which, if selected, will display integer values
in hexadecimal format. For example if the controller’s comms array element contained the value
31, the HMI panel would display this as 1F.

Width specifies the number of digits in the field, including any decimal point. For example, to
display 12.3 would require a width of 4 digits. The length of the field can also be adjusted
graphically by dragging the numeric field’s handles to make it wider.

The Reference options also include Variable, Recipe and Index. These are explained in detail in
Designer’s help file.

6.5.1.1 Data field properties
When using a serial HMI panel, there are two possible data type selections, Comms and Comms
Raw. Comms is used for the transfer of integer or floating point data that includes fractional data.
If the WORD or DBLE WORD data formats are selected, the scaling must be set to suit the
number of decimal places to be displayed (see section 6.5.1.3). If the FLOAT data format is
selected then scaling is not necessary, although it may still be used if required. The HMI panel
will show the float value read from the controller, rounding up the value to the chosen number of
decimal places in the numeric field. Comms Raw is used for the transfer of the integer part of a
number only. Comms Raw allows the scaling to be left at its default unity value and is therefore
simpler to configure, although it cannot be used to display floating point values accurately.

When using a CANopen HMI panel alternative options are available, since the data is being
stored on the HMI panel. The INT32_DB data type refers to the integer array of the HMI panel’s
memory, whereas the FLOAT_DB data type refers to the float array. The correlation between
these memory locations and the location specified by the controller’s Comms keyword is
explained at the beginning of section 6.3.

The Data Formats that are available depend on whether a serial or CANopen HMI panel is being
used. The BIT format allows a numeric field to set a single bit within the 32-bit data type of a given
memory location. This allows very efficient use of memory space for simple on/off yes/no type
data, and allows more than one piece of data to be stored in one memory location. Similarly, the
BYTE option allows a single memory location to hold four separate 8-bit values, and the word
option allows it to hold two 16-bit values. In each case, the limit values on the Range tab change
automatically to show the allowable values for the chosen format.

6.5.1.2 Range tab
The Limit values change automatically to show the correct limits for the data format selected on
the Data field Properties dialog. They are also affected by the choice of Signed / Unsigned on the
General tab, since this determines whether negative (i.e. a signed) values are allowable. The
Range tab provides two options for the limit values: Constant or Reference. In the examples,
only the constant option was used, which means that the limits for the numeric field were fixed by
the project. The Reference option allows a limit to be defined by the value in a memory location,
meaning that the limit can be altered at any time by changing the value in the memory location.
The ... button below the Reference option allows the memory location to be selected.
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6.5.1.3 Scaling tab
The HMI panel can scale the value read from the controller (or for CANopen HMI panels, the
value in the HMI panel memory) before it is displayed. The scaling factors are used in the formula
y = (A1/A2)x + B, where y is the value that will be displayed and x is the value read from the
controller or HMI panel memory.

For example, the Celsius to Fahrenheit conversion formula is: F = (9/5)C + 32. So, if a controller
provides the HMI panel with a Celsius value, the scaling factors could be set to A1=9, A2=5,
B=32 to make the HMI panel display the value in Fahrenheit.

The Reference option allows a scaling factor to be defined by the value in a memory location,
meaning that the scaling factor can be altered at any time by changing the value in the memory
location. The ... button below the Reference option allows the memory location to be selected.

When using a serial HMI panel, scaling may be essential when using the Comms data type in
conjunction with the WORD or DBLE WORD data format. When supplying a value in a comms
communication, the controller formats the value as ASCII characters, including a decimal point
and four decimal places.* Since the HMI panel does not recognize the decimal point when using
the WORD or DBLE WORD format, the value must be scaled by the HMI panel to reposition the
decimal point before displaying the value. Furthermore, the scaling is altered if a fixed point
placement value has been specified on the General tab, since this also causes the position of the
decimal point to be adjusted. In summary, the following scaling factors should be included when
using the Comms data type:

Data to be displayed Fixed point Placement value A2 scaling factor

Integer Not selected 10000

x.x (one decimal place) 1 1000

x.xx (two decimal places) 2 100

x.xxx (three decimal places) 3 10

x.xxxx (four decimal places) 4 1

When using the Comms data type in conjunction with the FLOAT data format, or when using the
Comms Raw data type, it is not necessary to adjust the scaling.

6.5.1.4 Text and Attributes tabs
These tabs can be used to alter the appearance and printing attributes of objects on the HMI
panel’s display. The available options depend on the type of HMI panel that is connected, and
are explained in detail in Designer’s help file.

6.5.1.5 Using the ASCII style
When using the ASCII style (typically for recipe names), care must be taken to allow sufficient
storage space. For example, if an ASCII field is added with a width of 10 (characters), and the
Address Reference set to COMMS1, then the COMMS1, COMMS2 and COMMS3 locations will
all be required to store the field. This is because each location can hold only 4 bytes (characters),
so COMMS1 and COMMS2 will hold 4 characters each, and COMMS3 will hold 2 characters.
Attempting to use COMMS2 and COMMS3 to store other data will result in corruption, so they
must not be used.

* Some older generation Mint v4 controllers use only three decimal places.
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7.1 Introduction
This section explains common problems that may be encountered, together with possible
solutions.

7.1.1 Problem diagnosis
If you have followed all the instructions in this manual in sequence, you should have few
problems installing the HMI panel. If you do have a problem, read this section first.

7.2 LED indicators
Various LED indicators are present on the HMI panels:

Battery status / key feedback (the ? symbol may not be present)
Flashing red: The battery voltage is low.
Solid red: There is a hardware fault.
Solid green: A key is being pressed.

Operation:
Off: Hardware fault / panel is not powered.
Solid green: Panel is powered and operational.

Communication:
Flashing green: Hardware fault or no communications.
Solid green: Communication operating correctly.

Alarm:
Flashing red: Alarm requires acknowledgement.
Solid red: Alarm active.

7 Troubleshooting 7
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7.2.1 Communication

Problem Solution

Cannot enter
configuration
mode.

If it is difficult to select configuration mode, try the following
procedures:

HMI panels with keys:
1. Turn off the HMI panel.
2. Press and hold any 3 keys.
3. Turn on the HMI panel.
4. Keep holding the three keys until configuration mode appears.

Touchscreen HMI panels:
1. Turn off the HMI panel.
2. Touch and hold the middle of the left side of the display.
3. Turn on the HMI panel.
4. While still pressing the left side of the display, repeatedly touch the
middle of the right side of the display, about once per second.
Continue until configuration mode is displayed.

The optional
CANopen module
does not seem to
be working

With the HMI panel powered and connected to the PC:

1. Run the Designer software.
2. From the menu, select Page, Special Pages and Page Modes,
System.
3. Scroll to the bottom of the display to see diagnostic information for
the CANopen module.

For example, this might show:
OPT032-501 0 H100 X030 OK

where:
OPT032-501 is the name of the module,
0 H100 X030 are the internal codes, with the first digit being the
error code (see below)
OK shows the module is operating correctly.

The following error codes may be shown:
0 No errors
05 Time-out error - the controller has stopped sending Node Guarding
messages after initiating the node guarding procedure.
06 Response error - Error in the response from the controller.
07 General error - internal software error.

Ensure that the CANopen module has been installed correctly, as
described in section 3.2.3.
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8.1 Introduction
This section provides technical specifications for the HMI panels.

8.1.1 24 VDC supply input
KPD

KG420-10
KPD

KG420-20
KPD

KG420-30
KPD

KG840-10

Nominal input voltage 24 VDC

Min. input voltage 18 VDC

Max. input voltage 30 VDC

Maximum continuous
current @24 VDC

250 mA 250 mA 300 mA 400 mA

KPD
TS03M-10

KPD
TS05M-10

KPD
TS05C-10

KPD
TS10C-20

KPD
TS12C-20

Nominal input voltage 24 VDC

Min. input voltage 18 VDC

Max. input voltage 30 VDC

Maximum continuous
current @24 VDC

400 mA 600 mA 600 mA 700 mA 800 mA

8 Specifications 8
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8.1.2 Display
KPD

KG420-10
KPD

KG420-20
KPD

KG420-30
KPD

KG840-10

Technology LCD LCD

Characters (row x char) 4 x 20 8 x 40

Graphics (pixels) 120 x 32 240 x 64

Dimensions (mm) 70 x 21 127 x 34

Backlight LED CCFL

Touchscreen No No

KPD
TS03M-10

KPD
TS05M-10

KPD
TS05C-10

KPD
TS10C-20

KPD
TS12C-20

Technology LCD LCD STN TFT TFT

Characters (row x char) Scalable

Graphics (pixels) 320 x 240 320 x 240 320 x 240 640 x 480 800 x 600

Dimensions (mm) 77 x 58 121 x 91 121 x 91 218 x 159 246 x 184

Backlight LED LED CCFL CCFL CCFL

Touchscreen Yes Yes Yes Yes Yes

8.1.3 Keys and LEDs
KPD

KG420-10
KPD

KG420-20
KPD

KG420-30
KPD

KG840-10

Function keys 4 9 12 23

System keys 7 10 23 24

User LEDs 5 10 13 24

System LEDs 4 4 4 5

KPD
TS03M-10

KPD
TS05M-10

KPD
TS05C-10

KPD
TS10C-20

KPD
TS12C-20

Function keys
(Touchscreen)

1 1

System keys
(Touchscreen)

User LEDs 0 1

System LEDs 0 5 5 4 4



www.baldormotion.com

Specifications 8-3MN1932

8.1.4 Serial RS232 / RS422/485 interface

Unit All models

Signal RS232, RS422, RS485

Bit rate baud 9600, 19200, 38400

8.1.5 Environmental
KPD

KG420-10
KPD

KG420-20
KPD

KG420-30
KPD

KG840-10

Operating temperature
(EN60068-2-14)

0 - 50 °C
(32-122 °F)

Storage temperature
(EN60068-2-14)

-20 to +70 °C
(-4 to 158 °F)

Operating & storage
humidity
(EN60068-2-30)

5% - 85%
relative humidity, non-condensing

IP rating (front panel) IP65

Shock
(EN60068-2-27)

50 G, 11 ms, 3 pulses per axis

Vibration
(EN60068-2-6)

10 - 57 Hz, 0.075 mm peak
57 - 150 Hz, 1 G

KPD
TS03M-10

KPD
TS05M-10

KPD
TS05C-10

KPD
TS10C-20

KPD
TS12C-20

Operating temperature
(EN60068-2-14)

0 - 50 °C
(32-122 °F)

0 - 45 °C
(32-113 °F)

Storage temperature
(EN60068-2-14)

-20 to +70 °C
(-4 to 158 °F)

Operating & storage
humidity
(EN60068-2-30)

5% - 85%
relative humidity, non-condensing

IP rating (front panel) IP65

Shock
(EN60068-2-27)

50 G, 11 ms, 3 pulses per axis

Vibration
(EN60068-2-6)

10 - 57 Hz, 0.075 mm peak
57 - 150 Hz, 1 G

The HMI panels comply with the following standards:

Emitted interference: EN 50081-2, 1993
Noise immunity: EN 61000-6-2, 2000
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If you have any suggestions for improvements to this manual, please let us know. Write your
comments in the space provided below, remove this page from the manual and mail it to:

Manuals
Baldor UK Ltd
Mint Motion Centre
6 Bristol Distribution Park
Hawkley Drive
Bristol
BS32 0BF
United Kingdom.

Alternatively, you can e-mail your comments to:

manuals@baldor.co.uk

Comment:

continued...

Comments
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Thank you for taking the time to help us.
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